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Abstract: To reconstruct past climate conditions from speleothems, palaeoclimate researchers utilize 
a variety of advanced but expensive methods, including various stable isotope ratios and trace element 
analyses. Greyscale changes can be related to growth and matrix density variations in stalagmites, which 
in turn are probably dependent on drip rate and dripwater Ca-supersaturation, among other factors. 
Greyscale analysis is particularly helpful where annual layers are found in stalagmites as the greyscale 
data can be used to build layer-counting chronologies, similar to varve counting in lacustrine and marine 
sediments. Greyscale information can further be used as a valuable palaeoclimate proxy. Depending on 
stalagmite growth rate a spatial resolution of less than five micrometres can be obtained, which might 
translate to seasonal temporal resolution. Here, we present a low-cost and high-resolution method for 
acquisition and analysis of greyscale data from speleothems by means of the free ImageJ software. We 
show how greyscale data can be acquired and visualized and describe how proxy time series can be 
constructed and proxy record uncertainties estimated using numerical methods. Finally, we provide an 
example for the application of ImageJ for greyscale analysis on stalagmites. The methodology outlined 
might be of use to geoscientists working on laminated sediments, and speleothems in particular.
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Introduction
Recent decades have seen an astonishing rise in the use of 
speleothems as palaeoclimate archives, because these chemical 
sediments offer precise and accurate absolute chronologies as 
well as a multitude of proxy information (Fairchild et al., 2006; 
Henderson, 2006; McDermott, 2004; Kennett et al., 2012; 
Ridley et al., 2015; Wong and Breecker, 2015; Baldini et al., 
2021). The complex interactions between the hydrochemistry 
and crystallography in the soil–host rock–stalagmite system 
complicate interpretation of geochemical proxy data in terms of 
climate variations. An approach to overcome this problem is to 
establish multi-proxy records, where different proxies allow for 
a deeper understanding of the studied system (see Baldini et al., 
2021, and references therein). Where elements or other highly 
resolved proxies can be linked directly to seasonal environmental 
changes like infiltration and prior carbonate precipitation, 
these can be used to develop layer-counting chronologies (e.g., 
Smith et al., 2009). However, financial constraints often limit 
the wider application of such geochemistry-based approaches. 
Thus, it is appropriate to outline low-cost methods that allow the 
acquisition of proxy data that contain detailed information on 
(palaeo-)environmental dynamics.

Whereas some researchers have used greyscale analyses for 
speleothem-based palaeoclimate reconstructions (Genty and 
Quinif, 1996; Niggemann et al., 2003; Webster et al., 2007;

Jex et al., 2010; Boch et al., 2011; Hopley et al., 2018; Louys et 
al., 2022;), we find that in speleothem science researchers seem 
not yet to have taken full advantage of digital image analysis 
for the acquisition of palaeoclimate and palaeoenvironmental 
information. Greyscale refers to the amount of light recorded 
as shades of grey in a pixel of an image, i.e., it represents light 
intensity in that pixel. A grey value of zero means the pixel is 
black, while higher values refer to increasingly whiter pixels (in 
8-bit images a grey value of 255 is white).

Members of the aquatic palaeoclimate research community, 
investigating marine and lacustrine sediments, have long made 
use of density and greyscale variation to characterize and measure 
annual laminations (varves) (Pike and Kemp, 1996; Rodbell et 
al., 1999; Nederbragt and Thurow, 2001; Marwan et al., 2003; 
Patterson et al., 2007; Ebert and Trauth, 2015; Oriani et al., 
2022). Similarly, digital methods have long been used to extract 
palaeoenvironmental information for detailed tree-ring studies 
and the tree-ring research community has developed a range of 
software tools for this purpose (see for example, McCarroll et 
al., 2002; Divya and Kaur, 2021). Some of these tools have been 
applied successfully to improve stalagmite chronologies (e.g., the 
TSAP_Win software, Riechelmann et al., 2019a). In combination 
with U/Th dating, floating chronologies based upon layer counting 
can be anchored, and the age uncertainties of speleothem-based 
time series can be reduced (Domínguez-Villar et al., 2012).



Other software tools including WinDendro (Regent 
Instruments Inc.) or WinGeol (Meyer et al., 2006) allow semi-
automatic layer detection and analysis. The latest analytical 
developments include machine-learning approaches (Sliwinski 
et al., 2023), which – with ever-improving computing power 
– might revolutionize fast and reliable extraction of seasonal 
information from laminated archives. A key issue with many 
professional software packages is their associated licence costs, 
which commonly restrict the application of digital analysis 
to specialized laboratories, beyond the budgets of less-well 
supported researchers.

An alternative is ImageJ, a powerful Java-based public-
domain software (Rasband, 1997–2004) that enables 
researchers from many fields, including astronomy (McGlynn 
et al., 2008), microbiology (Schiøtt et al., 2008; Ishino et 
al., 2009), remote sensing (Balic and Koch, 2009), geology 
(Fischer et al., 2006), and palaeoclimatology (Raffi et al., 
2005; Boës and Fagel, 2008; Thomas and Briner, 2009), to 
extract the information archived in their diverse samples in a 
reliable and reproducible way.

Stalagmites vary in isotopic, colour, fabric and crystal 
density, depending upon a variety of controlling factors, e.g., the 
presence of organic substances (Shopov et al., 1994; Baker et 
al., 1996), trace element content (Fairchild et al., 2001, 2006), 
and Ca-saturation state, growth rate (Gabitov et al., 2012; Frisia 
et al., 2022), and chemical composition of the dripwater (Frisia 
et al., 2005, 2022). Speleothem fabrics provide a rich archive of 
information about environmental conditions at the time of their 
formation (Frisia, 2015), the details of which are well beyond 
the scope of the present study.

In this study we do not provide a comprehensive discussion 
of the various physico-chemical parameters that can affect 
speleothem crystallization and fabrics. Instead, we focus 
on the extraction of information on growth changes linked 
to carbonate precipitation rate and crystal density, which 
allow us to construct layer-counted chronologies, and/or 
gain insights into seasonal to multi-annual environmental 
dynamics. Complex relationships between stalagmite growth 
laminae and climate in an Alpine cave are discussed by Boch 
et al. (2011). Connecting microclimatic data and geochemical 
monitoring they were able to disentangle the climatic 
parameters that lead to lamination changes. However, the 
processes producing annual laminae in a stalagmite are likely 
to differ depending upon local environmental conditions at 
each study site. Grey values, measured in speleothems along 
the growth axis, are likely to change with matrix density 
(Genty and Quinif, 1996). Lower grey values commonly 
correspond to high CaCO3 matrix density, whereas higher 
grey values are related to higher matrix porosity (low density). 
In reflected-light scans, dense CaCO3 with a microcrystalline 
structure often appears more transparent but is darker in 
scanned images because of the samples’ lower reflectance. 
Porous crystals generally appear rather opaque, leading to 
brighter grey values, as the scanning light reflection increases. 
Factors controlling the matrix density are commonly related 
to changes in stalagmite growth rate, which in turn depend 
on the soil pCO2, the hydrochemistry in the overlying host 
rock, and ultimately (cave) climate (Fairchild and McMillan, 
2007). Thus, stalagmite greyscale data can provide a powerful 
proxy for hydrochemical, and hence palaeoenvironmental, 
variability in the past.

We note that images obtained using other optical methods, 
such as petrographical and fluorescence microscopy, can be 
scrutinized in a similar fashion to the methods outlined here 
(Baker et al., 1993; Baker et al., 1996; McGarry and Baker, 
2000; Baker et al., 2008; Hopley et al., 2018). Microscopic 
techniques allow even higher (even sub-micron level) resolution, 
but come with different complexities, including the need for thin 
sections and advanced equipment. Importantly, petrographical 

microscopy uses transmitted rather than reflected light, which 
means that the interpretation of low and high grey values differs 
to that of grey values obtained using reflected light. Another 
potential issue that needs to be recognized and corrected is the 
potential distortion of microscopic images (i.e., changes of the 
shape of an image such that the true sample geometry appears 
altered). Flatbed scans have the light source always vertically 
above the object, rendering distortion insignificant. If these and 
other factors are considered carefully, grey values from such 
images can be analysed in the same way as described here and 
can give extremely detailed insights into sub-annual to multi-
annual environmental dynamics.

Some stalagmites do not exhibit clearly visible banding, or 
observed layers are related to inclusion of detrital (silt/clay) 
material deposited during erratic flood events rather than to 
seasonal growth changes (Dasgupta et al., 2010; Louys et al., 
2022) and this can prove challenging for greyscale analysis 
as described below. Where grey values vary regularly on a 
seasonal scale, greyscale analysis can help to establish a 
chronology based on layer counting. An important precondition 
for the formation of (seasonal) layers is that the hydrological 
regime of a cave reacts fast enough to seasonal environmental 
changes, and that the carbonate deposition rate is appropriately 
high. A counting chronology (similar to varve chronologies in 
lake sediments, e.g., Mangili et al., 2007) should ideally be 
confirmed by independent methods, such as U/Th dating. An 
example of a speleothem record based on a combined layer-
counted and U/Th chronology for a stalagmite is provided by 
Myers et al. (2015).

Below, we outline how ImageJ can be used as a low-cost yet 
effective digital tool to acquire greyscale values from stalagmites 
to construct layer-counting chronologies and proxy time series 
that can inform on seasonal changes in carbonate deposition 
during stalagmite formation.

Sample preparation setup
The described extraction and analysis of greyscale data is based 
on grey values observed in a stalagmite. As mentioned, grey 
values vary with changes in carbonate density, crystallographic 
fabrics, and organic content (if UV or confocal data are used), 
which depend on environmental conditions during carbonate 
deposition. The grey values are extracted from images of a 
stalagmite surface obtained using a flatbed scanner, with the 
scan image being based on reflected, rather than transmitted, 
light. This is a significant difference to petrographical thin 
section analysis, where transmitted light is used (e.g., Aharon 
et al., 2006).

Prior to scanning, a speleothem surface is prepared by cutting 
a stalagmite in half along its growth axis, normally with a rock 
saw or a wire saw. Depending upon the smoothness of the result, 
the cut surface might require polishing. This normally requires 
access to a laboratory equipped with a polishing table, and 
appropriate experience in polishing relatively soft rocks, though 
do-it-yourself solutions using sanding and polishing tools have 
been tested successfully. In some cases high porosity renders 
a sample unsuitable for polishing, because carborundum paste 
becomes trapped in the pores and interstitial spaces between 
crystals. The trapped paste is difficult to remove (even using 
ultrasonic methods) and it can bias the grey shading of the 
sample. Dry sandpaper and handheld drills with polishing 
attachments help in some instances, and a sufficiently smooth 
surface might even be obtained without polishing, simply by 
using a rock saw. 

To obtain high-quality scans the sample surface should be 
free of scratches from cutting, because these would appear as 
spurious grey values within the scan. Samples that exhibit dense 
crystal growth and horizontally deposited laminae are more 
likely to show regular seasonal growth changes and are ideally 
suited for greyscale analysis.
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Greyscale data acquisition
Required instrumentation
and software
A flatbed scanner with a scanning resolution of 
3600 dpi (dots per inch) or higher is recommended 
for greyscale data acquisition. ImageJ is freely 
available online [ https://rsb.info.nih.gov/ij/ ] and 
runs on most operating systems. For pre- and post-
processing of the scanned images, image editing 
software (such as AdobePhotoshop® or Gimp) 
might prove useful, although ImageJ itself supports 
advanced image manipulation. The extracted data 
can be explored further using any spreadsheet 
or data analysis software. Data analysis and 
visualization can be achieved using Goldensoft 
Grapher®, Octave, MATLAB™, Python, Julia, 
or similar software. MS Excel® is of only limited 
use when large data series are gathered and need 
to be illustrated or if more-complex data analysis 
is necessary.

Considerations for scanning
First, a decision has to be made as to which spatial 
resolution is actually needed. An image of a 
polished stalagmite surface, scanned at 4800 dpi 
gives a spatial resolution of 5.29µm/pixel (Fig.1). 
Higher resolution is possible but renders image 
handling more cumbersome, especially when 
using long scanned sections. 

As mentioned above, far higher (sub-micrometre) 
resolution can be achieved using microscopic 
images (e.g., when studying UV fluorescence) 
(Baker et al., 1993; Hopley et al., 2017). 

The scan resolution should thus be adjusted 
depending on the average growth rate of the 
sample, typically in the range of 50µm/year to 
200µm/year (Baldini et al., 2021). If, for example, 
a stalagmite grew 15µm/year a scan with 1200 
dpi resolution would result in 7.1 pixels (samples) 
per year, which would make it difficult to identify 
annual growth bands (Table 1, Fig.2). Using a 
scan resolution of 3200 dpi on the same sample 
would give about 19 samples per year, i.e., roughly 
three-weekly resolution, which would suffice for 
annual layer identification even if growth rates 
vary slightly.

Submerging the stalagmite in a water-bath on 
the scanner glass can help to enhance contrast 
and brightness. Attention must be paid not to 
trap air bubbles between glass and stalagmite. 
To avoid water entering the scanner, plasticine 
or a reusable adhesive such as Blu Tack®, can be 
used to model a dam around the sample on the 
scanner. If subsequent geochemical investigations 
are planned, the use of high-purity (or at least 
distilled) water is recommended. Covering the 
sample with an opaque plastic or cardboard box 
prevents unwanted light scattering.

An 8, 16, or 32-bit greyscale scan can then be 
taken at the desired spatial resolution, whereas the 
pixel depth (the bit-number) defines the number 
of grey levels, i.e., 8-bit has 256 grey levels 
(usually sufficient), 16-bit 65,536 grey levels, 
and 32-bit more than 4 billion. The image should 
be saved as a .tiff file. Image formats that induce 
data loss during compression (e.g., .jpg) are not 
recommended. It is good practice to include a 
scale in the scan, and to record the dpi setting used 
during scanning.

Scan resolution
(dots per inch)

Pixel size 
(µm)

Stalagmite growth 
rate (µm/year)

Samples 
per year

Sampling
time

4800 5.29 200 37.80 9.65 days
150 28.40 12.9 days

50 9.50 38.4 days
10 1.90 6.8 months

5 00.95 13.7 months

3200 7.94 200 25.20 14.5 days
150 18.90 19.3 days

50 6.30 1.9 months
10 1.30 9.2 months

5 0.60 1.7 years

1200 21.17 200 9.40 1.3 months
150 7.10 1.7 months

50 2.40 5.1 months
10 0.50 2.1 years

5 0.20 4.2 years

Figure 1: Relationship between the scan resolution in dpi and the spatial (pixel) 
resolution. For example, at 4800 dpi scan resolution, the spatial resolution of greyscale 
data will be 5.29µm (dashed line).

Table 1: Temporal resolution achieved at different scan resolutions and selected 
stalagmite growth rates.

Figure 2: Relationship between stalagmite growth rate, sampling time, and obtainable 
number of samples/year at selected scan resolutions.



Working in ImageJ
The scan image obtained can be opened in ImageJ, and contrast and 
brightness can be adjusted on-screen for better visibility (with no 
effect on the image; all grey values will be recovered). Ensure that 
a working copy of the image is used, and keep the original scanned 
image in a different folder or under a different and unmistakable 
file-name, to avoid accidental manipulation of the original image. It 
is also strongly advised that a version control system such as GIT 
is employed to monitor progress and maintain backups of previous 
stages of the work.

To link grey values to a metric distance rather than to a number of 
pixels, the measurement scale needs to be defined using the set scale 
tool in ImageJ (Analyze > Set scale), which relates a pixel distance to 
a known distance (e.g., a ruler scanned together with the sample). For 
example, a scan of 4800 dpi corresponds to 188.89 pixel per 1000µm.

The easiest way to extract a greyscale track (a single line) is to select 
the Line Tool (in ImageJ’s main menu) and draw a line along a transect 
of choice (the line can also be ‘segmented’ or ‘freehand’ to allow easier 
tracking of the growth axis). The selected line can be thickened to get 
average values of a range of pixels along the line (Image > Adjust > 
Line Width). Widening the track can reduce noise because the recorded 
grey values are less likely to stem from random particles or holes on 
the trackline. We recommend a trackline width of between 7 and 30 
pixels, although this is highly dependent upon sample characteristics, 
and ideally should be tested for each individual sample.

To ensure reproducibility of the analysis by other researchers, the 
trackline should be saved as a region of interest (ROI) in the ROI 
Manager (this can be found in Analyze > Tools > ROI Manager). This 
supports the saving of a ROI file (ROI Manager: More > Save), extraction 
of the coordinates of the trackline (ROI Manager: Properties > List 
coordinates), and the re-use of previously defined tracks (ROI Manager: 
More > Open), thus allowing the reproduction of results. We define a 
track as a single line along the stalagmite growth axis (perpendicular to 
growth layers, Fig.3) that is stored in a track.csv file. A number of 
tracks can be stacked into a profile (profile = n tracks).

In ImageJ, the grey values can be plotted against 
distance using the key combination of Ctrl+K. If the scale 
has not been set, the pixel number will be shown instead 
of the metric distance. The grey values can be saved as 
track.csv output (in the window with the grey values 
under Data > Save), and the drawn trackline can be added 
permanently on the image using the key combination 
Ctrl+D (ensure that the changes are made on a working 
copy and not on the original scan, because this line is 
added permanently to the image).

The procedure outlined above is useful for single 
tracks or for short intervals of interest. For more complex 
analyses, especially on samples characterized by changes 
in growth axis angle, some refinements of the procedure 
might be desirable. If a long transect, including changes 
in growth direction is planned, it is recommended to draw 
marker lines (with a width of 1 pixel) along certain distinct 
features parallel to selected growth layers, dating samples 
or similar points that serve as stratigraphical markers 
(Fig.3A) before starting the actual profiling of tracklines. 
These marker lines help in the stacking of multiple 
tracklines into a combined master profile, and to define 
the distances of features of interest (e.g., visible hiatuses, 
dating samples, changes in growth axis, etc.) along the 
master profile. For maximum accuracy, each track should 
be bracketed by a starting marker and an end marker line. 
For a larger project we recommend initial preparation of 
a sample scan with all required marker layers. After all 
marker lines are defined, the entire (stacked) profile can 
be developed and drawn over the entire length of interest. 
It might be useful to record the marker lines in the ROI 
Manager for archival purposes.

Because the grey values are black (i.e., zero or near-
zero) at the position of the marker lines (Fig.3C), their 
position can be identified readily on the transect of interest. 
Since the marker line grey values are added artificially, 
subsequently they should be replaced by either the true 
grey values (to avoid gaps in the stacked profile) or as a gap 
in the profile (commonly the loss of 1 pixel of information 
is not significant for the reconstruction). The grey values 
beneath the marker lines must be determined manually. If 
the tracklines have been saved as ROI the track can be 
redrawn without the marker lines to obtain the grey values 
formerly beneath them.

Whereas the marker lines are kept as thin as feasible 
to minimize any data gaps, the thickness of the trackline 
(Image > Adjust > Line Width or Properties > Width if using 
the ROI Manager) may be adjusted to avoid unwanted noise 
(as mentioned above). Commonly a trackline thickness of 
15 to 30 pixels reveals growth patterns more accurately, 
and the grey values are more representative compared to 
single-pixel tracklines (depending upon scan resolution 
and sample characteristics). In each case the ideal trackline 
thickness should be evaluated manually, because growth 
and fabric characteristics vary from sample to sample.

In a stacked profile, the end marker of the first track serves 
also as the start marker for the second track and so on. This 
strategy allows the user to adjust the track to follow changes 
in the direction of the growth axis, or to avoid holes, cracks, 
or other features that are unrelated to seasonal growth 
patterns. When starting to record tracklines, a line can be 
created to follow the profile of choice. It is recommended 
that initially a track is drawn between two markers, without 
actually crossing the marker lines, and that the track quality 
is evaluated using Ctrl+K (Fig.3B), before extending the 
trackline across the marker lines for archiving (Fig.3C). 
This facilitates choice of the most representative transect 
before the final trackline is drawn and the data are saved in 
the respective track.csv file and ROI.

Figure 3: Plotting a grey value profile for selected tracklines. (A) marker lines 
and tracklines can be used to build a profile of n tracks. (B) A test track shows 
the quality of the grey profile before crossing the marker lines and fixing of the 
track. This test track can repeatedly be plotted to find the most suitable track. 
The chosen track is then extended to cross the marker lines and fixed on the 
image by Ctrl+D. (C) The track crosses the marker lines 1 and 2 (indicated 
as very low grey values) and can be used to tie further tracks (track 2, grey 
dashed line). The grey values can now be saved as, e.g., track.csv.
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Before moving on to extract the next trackline, the previous 
line should be saved as a ROI in the ROI Manager (using the 
Add button) and fixed on the image, using Ctrl+D, for archiving 
and visualization purposes (strictly speaking, the latter step is 
not necessary because the ROI ensures precise archiving of all 
track information). The track and marker lines should be labelled 
using a consistent and structured scheme to maintain automatic 
post-processing and reproducibility (e.g., track_01_year-
month-day.csv; start marker #01). For ease of handling, 
all tracks should be recorded consistently in the same direction, 
either from top downwards, or from base upwards.

Once all desired tracks have been recorded and saved, the 
individual track lengths must be combined in a master track and 
all individual lengths should be connected and related to ‘Distance 
from top’, i.e., relative to the apex of the stalagmite. To combine 
the track distances within a master record, it is simplest to start 
with the topmost track and proceed in stratigraphical order: track 
2 is found below track 1, and track 3 below track 2, etc.

Ideally the position of the first marker line is placed at the 
top of the stalagmite and defined as 0mm from top, so that the 
distances of track 1 will then not need to be adjusted. Track 2 
distances would then have to be redefined, however, such that 
all grey values above the top marker line are discarded. The 
distance of the top marker line of the second trackline is then 
defined as the distance of the bottom marker line of track 1 and 
the following distances are added to the first track. In this way, 
all tracks can be combined into a master record.

If the top of the stalagmite has been defined with a marker line, 
all distances in tracklines can be adjusted and linked to the top of the 
stalagmite. This track should be used for all other dating and proxy 
information – all distances of samples taken from the stalagmite 
should be measured from the same reference depth (here marker 
line 1). We define this track as the master record or reference track 
with respect to distances. As stated, all distances should only be 
either measured directly along this reference track, or projected 
onto it. Equally important is that this establishes a datum line, i.e., 
a reference point that defines the top of the stalagmite, and this 
serves as starting point for measuring and recording all distances. 
This is of great importance for linking proxy distances (e.g., 
grey values, stable isotopes, etc.) and discrete dating samples in 
preparation for age–depth modelling.

The raw distance data in a track.csv file contains the 
total length of a greyscale trackline drawn (from the start of that 
line to the end). This is obviously not the correct (final) distance 
of the master profile and corrections are necessary as outlined 
above. The relevant part of a trackline is the distance between the 
two marker lines; anything above or below is irrelevant for the 
composite profile and has only been recorded to allow detection 
of the marker lines. In the track.csv file, the low grey value 
of the marker line can readily be found and the distance of 
interest extracted. When using an analysis software, these marker 
lines can be found automatically by applying a threshold. From 
experience, the threshold can be defined as the 10%-quantile 
of the original image. Then, values below this threshold in the 
track’s grey values can be considered as the marker lines.

The values before the start marker and beyond the end marker are 
discarded from the master composite profile and the raw track.
csv data are imported into a spreadsheet. To avoid confusion, 
the spreadsheet should contain a column that contains the name 
and date of data acquisition of the track.csv file, and another 
column the distance from marker to marker (length of each track). 
A third column contains the total distance of the stacked composite 
profile (n tracks), and a fourth column contains the grey values.

Alternatively, an analytical scripting software (e.g., MATLAB) 
can be used, allowing automatic marker detection, merging of the 
single tracks, and definition of the final total (stalagmite-based) 
distance (an example MATLAB script combine_tracks.m 
can be found in a linked Zenodo archive: see Data and code 
availability below).

The composite data can now be explored for seasonal growth 
changes, layer thickness, changes in mean grey values, and layer-
counting purposes. To test whether the resulting reconstruction 
is accurate and representative, a second, parallel profile should 
be extracted in the same way (see for example Hopley et al., 
2018). Based on several (>3) profiles one can also calculate an 
average layer count and its standard deviation as estimate of 
counting uncertainty.

Constructing a greyscale time series
Once a composite greyscale profile has been compiled, the main 
task might be the construction of a time series of grey values that 
can be scrutinized for environmental signals that forced changes 
in speleothem growth, and, hence, the grey values. Below, we 
discuss two ways to construct greyscale time series. First, we give 
some considerations when building time series via interpolation 
between points of known age (today mostly obtained via U/Th 
dating). Secondly, we discuss how layer-counting chronologies 
can be constructed (e.g., based on grey values).

Henceforth, we refer to the “greyscale record” as the series 
of grey values based on distances, and to the “greyscale time 
series” as the grey values based on a timeline.
Interpolation-based chronologies
An established greyscale record can now be plotted against 
distance along the growth axis of the stalagmite. However, in 
order to study the greyscale variation as a time series, compare 
with independent proxy records, or analyse the profile statistically 
for archived periodic climatic/environmental changes, such as 
the El Niño–Southern Oscillation (ENSO) or the North Atlantic 
Oscillation (NAO), an age–depth model is needed to inform 
construction of a greyscale time series.

To construct such a time series of grey values with an interpolated 
chronology, at least two fixed dating points must be known along 
the track (e.g., based on U/Th dates or known historical events that 
can be identified in the stalagmite). Ages can be assigned to each 
grey value by interpolation and extrapolation between these dating 
points using a simple linear model, or more advanced methods like 
cubic, spline, or piece-wise shape-preserving cubic interpolation. 
A template analysis script chronology_with_uncert.m for 
various interpolation and extrapolation calculations (working with 
Octave and MATLAB) can be found in the linked Zenodo archive 
[see Data and code availability below]. A detailed discussion can 
be found in Breitenbach et al. (2012).

Whereas linear interpolation is the best method to use if only 
two dates are available, this method has the disadvantage that the 
age model can falsely suggest abrupt growth changes at the dating 
points, which renders the logic of the resulting age model faulty. 
This is because growth rate (i.e., the relationship between distance 
and age) would appear to change exactly where the dating samples 
have been taken, which is highly unlikely in nature. The growth rate 
would change either gradually, or somewhere between dating points, 
rather than at a specific (subjectively chosen) position. Additional 
disadvantages of linear interpolation, and also of other interpolation 
methods, are summarized in Scholz and Hoffmann (2011) and 
Breitenbach et al. (2012). Where multiple dates are available, we 
recommend use of interpolation techniques that provide smooth 
transitions at the dating points, such as cubic interpolation. 
Commonly interpolation is also necessary when subsequent time-
series analysis requires an equidistant timeline, although novel 
statistical approaches have been developed in recent years that can 
handle non-equidistant datasets (e.g., Rehfeld et al., 2011; Ozken et 
al., 2015). For a useful overview of numerical strategies for time-
series analysis see Chapter 9 of Kwiecien et al. (2022).

Here, in a first step, we define an equidistant timeline and 
calculate corresponding distances to this timeline by using 
the aforementioned interpolation procedure. In a second step, 
the distance-based greyscale record is interpolated to the 
equidistant timeline, resulting in a greyscale time series on an 
equidistant timeline.
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The measurements of the distances of grey values (or any proxy 
for that matter) and (mainly) the corresponding U/Th dates contain 
uncertainties. Using a simple Monte Carlo simulation (Breitenbach 
et al., 2012), we can estimate the confidence intervals of the 
chronology and translate them into confidence interval variations 
of the grey values themselves. This means that we can estimate 
what the most likely proxy value is at a given age.

One example: Consider a dating error of ∆T = ±50 years and 
a tiny error in the distance measurement of ∆D = 0.02mm. Then 
random numbers, derived from a normal distribution and scaled 
to the necessary corresponding error ranges, are added to the dates 
and position values of the dating points. This results in a new and 
slightly different realization of the age–depth relationship, which 
is, however, still within the range of the measurement errors. From 
this new realization, a new chronology for the greyscale profile 
is calculated. Next, the greyscale record is interpolated to the 
new timeline. By repeating this procedure many (say 1000) times 
(Monte Carlo simulation), many new realizations of age–depth 
relationships and interpolated greyscale records can be obtained. 
These can then be used to derive a distribution (an ensemble) of 
grey values for each time point, which allows us to estimate the 
standard deviation or a pre-selected quantile, mainly the 2.5% and 
97.5% quantiles, and, hence, the 95% confidence interval of the 
greyscale time series. We emphasise that uncertainty estimates of 
the proxy time series itself (be it grey layers, isotopes, elements 
or any other) are commonly absent in published stalagmite 
records. The methodology described above (and in more detail in 
Breitenbach et al., 2012) and provided in the Zenodo archive (see 
Data and code availability below) can be applied to any proxy 
and any sedimentary record, as long as the dating uncertainty 
is well known. The COPRA Toolbox, a free toolbox for Octave 
and MATLAB, includes this procedure and can be accessed at 
https://tocsy.pik-potsdam.de/copra.php.

Such simulations show that very small errors in the dating can 
cause rather strong variances in the greyscale time series. This 
uncertainty should be considered when interpreting the resulting 
proxy record in terms of past environmental changes.

Building layer-counting chronologies
Once a greyscale record (grey values versus distance) has been 
established, it might be possible to construct a layer-counting 
chronology.

In stalagmites a given layer is always older than the next one 
above it, similar to the innermost tree rings always being the 
oldest. This fundamental stratigraphical principle underlies our 
counting exercise where we use the greyscale profile to build a 
record of counted layers. We define an annual layer as the distance 
between two adjacent maxima (or two adjacent minima) within 
the greyscale record, assuming that growth conditions vary at 
seasonal scale, with environmental conditions in one season 
producing a denser, darker layer, and another season producing 
a whiter, more porous layer. A key assumption is that the layers 
are indeed formed at seasonal scale. Although not all caves 
support this type of seasonal variability and therefore seasonally 
variable carbonate deposition, seasonal growth changes have 
been observed in different climatic settings (Aharon et al., 2006; 
Johnson et al., 2006; Boch et al., 2011; Myers et al., 2015; 
Ridley et al., 2015; Baldini et al., 2021). Some stalagmites reveal 
multiple sub-seasonal (event) layers or missing annual layers 
(Shen et al., 2013) and it is strongly recommended to verify the 
seasonal nature of observed layers using an independent dating 
method, e.g., U/Th dating.

Because radiometric dating methods are commonly 
associated with larger uncertainties (many years, or even 
centuries), layer-counting chronologies remain floating, i.e., 
a layer-counted chronology can be (timewise) moved within 
the dating uncertainties of the independent dating method. 
However, the internal (year-to-year) accuracy of a layer-
counted interval is commonly far higher than the uncertainties 

related to the U/Th chronology. This realization allows 
new insights into seasonal and interannual environmental 
dynamics, regardless of the absolute calendar age. Given 
that two chronologies – layer-counting versus radiometric 
dating – agree within uncertainties, the annual character of 
the observed layers and the quality of the counting method 
are validated. If the annual nature of greyscale cycles is 
verified, the layer-counting chronology can further help to 
improve the relative timing and duration of events that might 
be detected with proxy data. Verification might be provided 
by observations of modern carbonate deposition (e.g., isotope 
analysis of monthly deployed watch glasses, Riechelmann 
et al., 2019b), chronological agreement between U-series 
dates and layer counts (Dominguez-Villar et al., 2012), or 
agreement between layer-counted age and events of known 
age in a sample (Baker et al., 2008).

Whereas the minima or maxima in the greyscale profile 
allow us to count years, it is impossible to assign the season 
to maximum or minimum grey values without detailed 
monitoring of microclimate and dripwater chemistry (Baldini 
et al., 2021; Kwiecien et al., 2022). Thus, the distance between 
two subsequent maxima (or minima) represents the annual 
deposition, without unequivocal information on the calendric 
season. Calculating the distance between the counted grey 
value peaks, the greyscale profile provides an annually 
resolved record of growth rate, which in itself can provide 
valuable environmental information because stalagmite 
growth rate depends directly upon local environmental 
conditions (Baldini et al., 2021).
Linking layer counting and U/Th chronologies
Various approaches have been proposed to link layer counting 
and U/Th chronologies. One method involves minimizing the 
distance between U/Th data and layer counts through a least-
squares fit, as described in detail in Breitenbach et al. (2012). 
To anchor the two chronologies Domínguez-Villar et al. 
(2012) used a linear relationship between the layer-counted 
chronology and the U/Th chronology, determined through a 
least-squares fit. Another approach is to assign a common age 
point to a given depth and use that tie point in both chronologies, 
without further testing for agreement between layer counting 
and U/Th results as in the previous methods. The tie point 
could, for example, be the centre of a U/Th dating sample as 
implemented by Finestone et al. (2022), or an event layer of 
known age that is used as a reference point for layer counting. 
These different strategies provide flexibility in linking layer 
counting and U/Th chronologies and offer insights into the 
temporal evolution of geological formations, while potential 
sources of uncertainty are being considered.

Uncertainties inherent to greyscale analysis
A single track along the growth axis might be rather subjective 
and it might be useful to evaluate the accuracy of the trackline 
with another parallel one, as mentioned above. Holes or 
dirt inclusions, etc., in the sample can falsify the grey value 
information (both greyscale proxy and chronology). Also, 
as shown nicely by element imaging (Treble et al., 2005), 
single layers might taper out with growing distance from the 
central growth axis, up to the extent of disappearance. Such 
sample characteristics will lead to falsification in a greyscale 
chronology because either too many or too few layers might 
be identified and counted. To minimize the impact of these 
issues, it is useful to adjust the width of the trackline such 
that it can be considered representative of the stalagmite. 
We find that a line width of between 7 and 30 pixels is often 
best to suppress unwanted noise (from, e.g., holes, cracks, or 
particles) and to extract well-expressed seasonal changes in 
grey values. The exact width that is best for each line should 
be tested because it depends upon the characteristics of the 
sample at hand. 
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This approach helps to avoid some – though not all – problems 
that can complicate the extraction of greyscale information. 
Missing layers (Shen et al., 2013) and crypto-hiatuses (Baldini 
et al., 2021) will likely remain undetected. It is obvious that the 
best samples are those displaying quasi-parallel lamination. On 
the positive side, if agreement between layer-counting and an 
independent dating method is found, the error resulting from the 
above-mentioned uncertainties is probably masked by the error 
of the radiometric dating method.

An example for greyscale analysis
We chose a short section of a stalagmite from northeastern India 
as an example for greyscale analysis. The entire dataset and the 
palaeoclimatic interpretation (δ13C, δ18O, and greyscale data) of 
this stalagmite are presented in Breitenbach (2009). Here, we use 
the greyscale information as an independent chronological tool 
and as an aridity proxy. We show only a short section of this set 
of data to illustrate the method outlined above. The 64cm-long 
stalagmite KRUM-3 originates from the cave Krem Umsynrang, 
in Meghalaya, northeastern India. This region is characterized 
by sharply pronounced rainfall seasonality, with >80% of the 
annual rainfall being delivered between June and October. After 
being collected in 2006, the laminated aragonitic stalagmite was 
subsequently analysed using geochemical methods, and has 
been dated using the U/Th method (for details see Breitenbach, 
2009). The cave is overlain by about 40m of sandstone and a 
thin coal bed.
KRUM-3 greyscale profile
To exemplify the outlined approach, we chose the KRUM-
3 section between 16mm to 32mm from the top (Fig.4), that 
corresponds roughly to track 1 and track 2 in Fig.3A. The 
unpolished stalagmite slab was scanned in a water bath at 
4800 dpi resolution with 8-bit pixel depth, and the grey values 
were extracted with ImageJ in the way described above. 
Petrographical microscopy revealed that dense microcrystalline 
layers are characterized by reduced growth rates. These intervals 
appear dark in the scan (Fig.4). The layer counting started at the 
top of the stalagmite with year 2006 AD when the stalagmite 
was collected. 

The profile shows large grey value variations, ranging from 
180 to 255. Cycles are clearly visible between the values of 
approximately 200 and 230. These cycles result from seasonally 
varying growth rates. Independent information (petrographical 
observations, higher δ18O and δ13C values) suggests that darker 
grey values reflect dry (season) conditions and reduced growth 
(Breitenbach, 2009). In turn, higher (brighter) grey values reflect 
wetter conditions during the Indian summer monsoon. The same 
interpretation of dark and bright layers, as mirroring dry and wet 
periods respectively, has been proposed by Aharon et al. (2006) 
in speleothems from Niue Island in the southwestern Pacific. 
Dark bands there were found to be linked to slower carbonate 
deposition reflecting a restricted dissolved inorganic carbon 
(DIC) load, whereas brighter layers were formed when increased 
infiltration led to a higher DIC load and faster crystal growth 
(Aharon et al., 2006). Whether faster growth occurs during the 
dry or wet season depends upon several factors, and monitoring 
is required to establish during which season growth is enhanced 
or suppressed. For example, in Mawmluh Cave, 1000m higher 
than Krem Umsynrang, on the Shillong plateau, faster growth 
(with more-porous and whiter crystals, and higher isotope 
values) is found in the dry season (Ronay et al., 2019).

Thus, the variability of the grey values serves as a proxy 
for local hydrological conditions. In northeastern India, the 
greyscale record obtained reflects changes in summer monsoon 
intensity. Similarities between the greyscale data and a record 
of ENSO changes in Peru suggests that hydrological seasonality 
and monsoon strength are influenced by ENSO dynamics, as 
also indicated by other studies (Breitenbach, 2009; Myers et al., 
2015; Ronay et al., 2019).

Sub-monthly temporal resolution can be obtained where 
high growth rates are found (in our example we obtain 15 to 
20 samples per year because the annual growth commonly 
exceeds 100µm). However, periods of reduced growth during 
dry intervals decrease the sampling to sub-decadal resolution. 
Such intervals can introduce larger counting uncertainties if the 
individual layers can no longer be distinguished, leading in turn 
to disagreement with U-series dating results.
KRUM-3 greyscale layer-counting chronology
The counted interval corresponds to 169 years between U-series 
dates U8 (405±7 yrs BP) and U32 (574±5 yrs BP) (Fig.4). The 
counting line starts at the centre of sample U8 and ends at the top 
of sample U32. Thus, the top end of the greyscale record should 
correspond to U-series age U8 and the lower end to within the 
uncertainty of U32. Counting from the top we find 221 layers 
between the two end points at 396 and 617 years BP, i.e., the top 
counted age is only marginally younger, and the lower counted age 
is 43 years older compared to the U-series dates (c. 7% difference 
between both ages). This mismatch between the U/Th chronology 
and the greyscale-based layer counting probably results from 
uncertainties in the layer counting and characteristics of the 
greyscale profile. Whereas the layers are strongly pronounced in 
most of the profile, the interval between 32mm to 30.5mm (Fig.4) 
is accompanied by reduced growth rates and lower grey values, 
making it difficult to identify layers correctly. 

For the KRUM-3 section, layers were counted for the 
past 5400 years. Repeated counting suggests that the overall 
disagreement between U/Th and counting chronologies is <5% 
(Breitenbach, 2009). Overall, the accordance between the two 
chronologies reveals the usefulness of layer counting based on 
grey values. The layer counting (c.5400 years) replaced the 
U-series chronology of the top half of stalagmite KRUM-3 
covering the entire Holocene (Breitenbach, 2009). This 
improved the final chronology for the entire multiproxy record 
(i.e., grey values, stable isotopes, and elements) and gave 
new insights into teleconnections between the Indian summer 
monsoon and the Pacific climate (ENSO) (Breitenbach, 2009).

Figure 4: A section from stalagmite KRUM-3 shows annual laminae. Its 
greyscale values vary between 180 and 255. The high spatial resolution 
and high stalagmite growth rate result in sub-monthly temporal 
resolution (15 to 20 samples/year). Grey values drop to a minimum of 
around 180 during a low growth interval (dark interval); similarly low 
values are found in a hole at 24.6mm. The counting error in such dark 
low-growth intervals is certainly higher, because the layers become ill-
defined. Annual cycles are clearly distinguishable in the zoomed section. 
A growth year has been defined as the interval between successive grey 
value maxima.
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The disagreement between the two independent dating 
methods also highlights the limitations of layer counting as a 
chronological tool, and careful examination is required to avoid 
underestimation and overestimation of ages in layer-counted 
chronologies (Shen et al., 2013).

It must be emphasized that the subjectivity in counting 
individual layers leads to a human bias during data acquisition. 
Subjective selection of the maximum or minimum grey values 
in a given year is unavoidable where counting is complicated by 
irregular layer thinning or even fading of layers in low-growth 
intervals (as for example between 16mm to 18mm from the top 
in KRUM-3, Fig.4). As mentioned above, such intervals are 
particularly prone to increased counting uncertainties. Where 
clear and parallel laminae are visible the error is likely to be 
tiny and different users will obtain the same counting results 
(e.g., 20mm to 22mm from top in KRUM-3, Fig.4). Automated 
methods are potentially faster and give robust and objective 
results, but likewise these need special controlling steps, because 
some features in the sample might remain undetected by any 
automated method (e.g., Meyer et al., 2006; Ebert and Trauth, 
2015; Sliwinski et al., 2023).

The layer-counting method is especially useful for establishing 
chronologies in cases where U/Th dating shows large errors, caused 
for example by low uranium or high detrital thorium contents. 
An exciting prospect is the extraction of sub-annual greyscale 
information from stalagmites that are too old for highly accurate 
U/Th chronologies to be obtained. Even under ideal conditions, 
U/Th dates from samples older than approximately 200,000 years 
probably have 2σ uncertainties of several hundred years (Cheng 
et al., 2013). If layers can be counted in such samples, floating, 
yet internally highly precise, layer-counting chronologies can give 
insights into changes in seasonality, short-lived extreme events, 
or sub-decadal- to sub-centennial-scale environmental dynamics 
(e.g., Hopley et al., 2018; Finestone et al., 2022).

Data visualization
The information from the processed greyscale dataset can be 
presented either as an age–depth plot (using the layer-counting 
information) or as time series of grey values (using the composite 
record). The former is important when evaluating growth-rate 
dynamics and whether layer-counted intervals correspond with 
independent dating information. In many cases the latter is the 
final product that palaeoclimatologists interpret in terms of past 
environmental changes. Commonly it is useful to show the time 
series with its confidence interval, although this visualization 
depends upon the research aims.

In addition to exploiting greyscale data for chronological or 
proxy information, 2.5D (pseudo-3D) block diagrams can be 
used to visualize fabric characteristics of a speleothem sample. 
Such diagrams can be produced using the ImageJ Interactive 3D 
Surface Plot plugin (Plugins > 3D), which is installed by default 
with ImageJ.

An interactive tool can be used to enhance the greyscale 
information of a selected area of interest within a stalagmite. 
Various options help to highlight the selected surface in 3D, 
where the z-axis will be represented by the greyscale data. An 
example is given in Figure 5. Unfortunately, no measurement 
options are available in this toolbox, or for images saved from 
the 3D tool. The advantage of plotting greyscale data in 3D space 
is the opportunity to investigate and accentuate diffuse changes 
within the speleothem. This tool is also especially helpful during 
data acquisition because it aids identification of representative 
growth patterns, disturbed areas, or holes.

Conclusions
We present an overview on the usage of the freely available 
software ImageJ as a tool for the extraction of greyscale 
information from stalagmites (and possibly other laminated 
sediments). Stalagmite greyscale data obtained with this software 
can be exploited as (i) a proxy record in case the grey intensity is 
related to crystallography, growth rate or organic content changes 
of the stalagmite, which themselves depend upon environmental 
dynamics, and (ii) as a means to establish a layer-counting 
chronology if the grey values show clear seasonal cycles.

Independent absolute time markers are needed to verify that 
cycles found in the greyscale profile are indeed seasonal. The 
computer scripts provided allow for the concatenation of individual 
grey value tracks and for interpolation between absolute datings 
or counted peaks. Furthermore, this latter script also estimates the 
uncertainty of the chronology of the record obtained. Lastly, an 
example of greyscale analysis on a stalagmite is given. Analogously, 
the ImageJ program, the scripts, and the described methods can be 
used for other sediments (ice, lacustrine, and marine cores). We 
hope that the presented analytical strategies will be of use to readers 
interested in extracting high-resolution data from stalagmites 
without the need for the high funding levels that are commonly 
required to support provision of detailed geochemical analyses.

Data and code availability
We provide three scripts for MATLAB and Octave to extract grey 
values from scanned images (extract_greyvalues.m), to 
concatenate grey value tracks (combine_tracks.m), and for 
interpolation and uncertainty estimation of the grey value record 
chronology_with_uncert.m. Use of Octave was tested 
with version 6.2.0 and of MATLAB with version 2023. The 
scripts with description and used data examples are available at 
Zenodo doi:10.5281/zenodo.7963381.
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Figure 5: Plotting a grey value profile of a selected area using the Interactive 3D Surface Plot plugin. The block image can be rotated, and parameters 
can be customized in ImageJ before export of the final image. Annual layers (the growth direction is from right to left) are clearly visible. 
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